Delineation of small reservoirs using radar imagery in a semi-arid environment: A case study in the Upper East Region of Ghana

Frank Ohene Annor

MSc Thesis WM. 07.06
April, 2007
Delineation of small reservoirs using radar imagery in a semi-arid environment: A case study in the Upper East Region of Ghana

Master of Science Thesis
by
Frank Ohene Annor

Supervisors
Prof. Pieter van der Zaag (UNESCO-IHE)
Prof. dr. Ir. Nick van de Giesen (TU-Delft)

Mentor
Dr. Amaury Tilmant (UNESCO-IHE)

Examination committee
Prof. Pieter van der Zaag (UNESCO-IHE)
Prof. dr. Ir. Nick van de Giesen (TU-Delft)
Dr. Amaury Tilmant (UNESCO-IHE)

This research is done for the partial fulfilment of requirements for the Master of Science degree at the UNESCO-IHE Institute for Water Education, Delft, the Netherlands

Delft
April, 2007
Disclaimer

The findings, interpretations and conclusions expressed in this study do neither necessarily reflect the views of the UNESCO-IHE Institute for Water Education, nor of the individual members of the MSc committee, nor of their respective employers.
I dedicate this thesis to the Lord God Almighty, the Ohene Annor, Amosah-Anobil and the Anderson family from Agona Swedru/Wineba; Ghana - West Africa.
Abstract

The importance of small reservoirs during droughts for the local population in most semi-arid environments cannot be overestimated. Water stored in these reservoirs allow for all-year-round irrigated agriculture for some farmers and ensures that there is little or no domestic and drinking water shortages for the local population during dry periods. In order to manage the water effectively for competing uses, the actual storage of these reservoirs need to be accurately estimated. Recent attempts to delineate these reservoirs using remote sensing with Landsat imagery have been quite successful especially in the Upper East region of Ghana, West Africa. This was done to determine the number; spatial distribution and storage volumes of reservoirs for effective water management and reservoir planning. However, the accuracy of the lateral delineation of these reservoirs needs further studies since it is paramount for its monitoring especially for purposes such as forecasting of crop failure in the dry seasons.

This thesis explains how radar images (ENVISAT-ASAR) can be used to provide all year-round monitoring. Radar has the important advantage that it is independent of cloud cover hence can be used in the rainy season. It can also be used to acquire both day and night time images. This study shows how a monthly regional inventory of storage in small reservoirs can be obtained. The study area is the Upper East Region of Ghana, West Africa. In comparing ground data with ENVISAT data, it becomes clear that reeds, which often can be found in the shallow tail-ends of reservoirs, can not be readily distinguished from the surrounding vegetation.

Keywords: Dams; ENVISAT-ASAR; Small Reservoirs; Ghana; Africa
Acknowledgements

I give thanks to Dr. Samuel Nii Odai, Prof. Nemanja Trifunovic and the IHE/PR-Kumasi;Ghana project team who through the Netherlands government have supported me both financially and academically through this MSc. Programme at UNESCO-IHE, Netherlands.

I am very grateful to my Supervisors: Prof. Pieter van der Zaag (UNESCO-IHE, Netherlands), Prof. dr. Ir. Nick van de Giesen of the Technical University of Delft (TU-Delft, Netherlands), and my Mentor: Dr. Amuary Tilmant (UNESCO-IHE, Netherlands) for their support, direction and guidance throughout my thesis.

Many thanks go to the GLOWA-Volta (Small Reservoirs project) team especially Tonya Schuetz and Dr. Boubacar Barry for their massive support and directions in carrying out this study especially the fieldwork.

To UNESCO-IHE (Netherlands) Water Management Staff members, Jens Reiner Liebe (Cornell University, USA), Freek van Leijen (DEOS, TU-Delft, Netherlands), Jennifer Hauck (ZEFc, Bonn, Germany), Mrs. Betty Rothfusz (TU-Delft, Netherlands), Mr. Daniel Schotanus (Netherlands), Cozmin Lucau and Didrik Pinte (UCL, Louvain-la-Neuve, Belgium), C.J. van der Sande (NEO B.V., Netherlands), Lucas Broekema (ESRI), Joost van der Sanden, Vern Singhroy and Goran Pavlic (CCRS, Ottawa, Canada); I say a big thank you for your valuable contributions.

I thank the ESA’s Tiger Project (AO2871) for the provision of the data used in this research work.

Juliet Abaliwano, Winifred Nabakiibi and Kwaku Amaning Adjei; you are such wonderful friends. I would not have been successful with this thesis without your assistance. I am truly grateful for your love and emotional support.
Table of Contents

Acknowledgements........................................................................................................... ii
List of Figures......................................................................................................................... iv
List of Tables.......................................................................................................................... v
List of Tables.......................................................................................................................... v
Abbreviations........................................................................................................................ vi
Abbreviations........................................................................................................................ vi

1.0 Introduction..................................................................................................................... 1
  1.1. Problem Statement ....................................................................................................... 1
  1.2. Research Goal, Objectives and Questions.................................................................... 1
    1.2.1 Research Goal ......................................................................................................... 1
    1.2.2 Research Objectives .............................................................................................. 2
    1.2.3 Research Questions .............................................................................................. 2
  1.3. Hypothesis................................................................................................................... 2

2. GIS and Remote Sensing for Water Resources and Hydrology ..................................... 3
  2.1. Delineation of reservoirs by Remote Sensing using Landsat and ENVISAT ASAR imagery ................................................................................................................................. 3
  2.2. ENVISAT ASAR data description ............................................................................... 7

3. Study area - The Upper East region of Ghana (UER) .................................................. 11
  3.1. Water Balance in the UER ......................................................................................... 12
  3.2. Importance of small reservoirs in the UER ............................................................... 12

4. Lateral delineation of reservoirs .................................................................................... 15
  4.1. Extracting the outline of reservoirs with ENVISAT-ASAR .......................................... 15
    4.1.1 Processing of images ............................................................................................. 15
  4.2. Extracting the outline of reservoirs with ground truth data ........................................ 17

5. Results and Analysis....................................................................................................... 19
  5.1. Field - Satellite Surface area correlation .................................................................... 19
  5.2. Surface area – volume correlation ............................................................................. 23
  5.3. Monthly Inventory of Storage in reservoirs ............................................................... 24

6. Conclusion and Recommendation .................................................................................. 27
  6.1. Specific Conclusion .................................................................................................... 27
  6.2. General Conclusion .................................................................................................. 27
  6.3. Recommendation ...................................................................................................... 28

References ............................................................................................................................ 29

APPENDICES....................................................................................................................... 33
List of Figures

Figure 1: Recent satellites (Source: Spaans, 2006) .............................................................. 7
Figure 2: ENVISAT-1 Satellite payload (Source: EIPS, 2007) .............................................. 8
Figure 3: The Upper East Region of Ghana, within the Volta Basin .................................. 11
Figure 4: Water Budget for Navrongo .............................................................................. 12
Figure 5: C-HH backscatter of a SLC image, 31st January, 2007 ......................................... 16
Figure 6: Ungeoreferenced and georeferenced image scenes of 31st January, 2007 ..... 17
Figure 7: Map showing the Locations of Dams/dugouts visited during the field work in the UER ................................................................. 17
Figure 8: Winkogo dam with reeds on the surface of the reservoir ................................. 18
Figure 9: Correlation between field surface area and satellite surface area ......... 20
Figure 10: Over classified Kongo reservoir ................................................................. 21
Figure 11: under classified Kamega reservoir ............................................................. 22
Figure 12: Variation in sediment yield (tons/km$^2$/year) over a 50-year record for Dorena Lake [Source: Ambers, 2001] ................................................................. 23
Figure 13: Reservoir storage in July, 2005 and August, 2005 .............................................. 24
List of Tables

Table 1: Features that are best identified in the various bands of a Landsat image ........ 5
Table 2: Radar-based satellites with coverage over the Upper East Region of Ghana .... 6
Table 3: Nominal ASAR Characteristics ................................................................. 9
Table 4: Technical Summary of ASAR Alternating Polarization Mode ......................... 9
Table 5 Description of data used in this research .................................................... 15
Table 6: Comparison of Field surface area with satellite area of reservoirs ............... 19
Table 7 Model Validation with three reservoirs ..................................................... 20
Table 8 Volume of reservoir estimated from satellite imagery .................................. 24
### Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Full Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASAR</td>
<td>Advanced Synthetic Aperture Radar</td>
</tr>
<tr>
<td>AVHRR</td>
<td>Advanced Very High Resolution Radiometer</td>
</tr>
<tr>
<td>BNI</td>
<td>Basic Need Income</td>
</tr>
<tr>
<td>DAI</td>
<td>Deviation Area Index</td>
</tr>
<tr>
<td>DEM</td>
<td>Digital Elevation Model</td>
</tr>
<tr>
<td>EIPS</td>
<td>EuriImage Product and Services</td>
</tr>
<tr>
<td>ENVISAT</td>
<td>Environmental Satellite</td>
</tr>
<tr>
<td>EPS</td>
<td>Envisat-1 Products Specifications</td>
</tr>
<tr>
<td>ESA</td>
<td>European Space Agency</td>
</tr>
<tr>
<td>ESRI</td>
<td>Environmental Systems Research Institute</td>
</tr>
<tr>
<td>ETM+</td>
<td>Enhanced Thematic Mapper Plus</td>
</tr>
<tr>
<td>FAO</td>
<td>Food and Agriculture Organisation</td>
</tr>
<tr>
<td>GIS</td>
<td>Geographic Information System</td>
</tr>
<tr>
<td>GPRSP</td>
<td>Ghana Poverty Reduction Strategy Paper</td>
</tr>
<tr>
<td>GPS</td>
<td>Global Positioning System</td>
</tr>
<tr>
<td>ICOUR</td>
<td>Irrigation Company for the Upper Regions</td>
</tr>
<tr>
<td>IDA</td>
<td>Irrigation Development Authority</td>
</tr>
<tr>
<td>IFAD</td>
<td>International Fund for Agricultural Development</td>
</tr>
<tr>
<td>LACOSREP</td>
<td>Land Conservation and Smallholder Rehabilitation Project</td>
</tr>
<tr>
<td>LIDAR</td>
<td>Light Detection and Ranging</td>
</tr>
<tr>
<td>MODIS</td>
<td>Moderate Resolution Imaging Spectroradiometer</td>
</tr>
<tr>
<td>MOFA</td>
<td>Ministry of Food and Agriculture</td>
</tr>
<tr>
<td>NASA</td>
<td>National Aeronautics and Space Administration</td>
</tr>
<tr>
<td>NDAI</td>
<td>Normalized Difference Area Index</td>
</tr>
<tr>
<td>NDWI</td>
<td>Normalized Difference Water Index</td>
</tr>
<tr>
<td>RADAR</td>
<td>Radio Detection and Ranging</td>
</tr>
<tr>
<td>RMS</td>
<td>Root Mean Square</td>
</tr>
<tr>
<td>SIMP</td>
<td>Slicks as Indicators for Marine Processes</td>
</tr>
<tr>
<td>SLC</td>
<td>Single Look Complex</td>
</tr>
<tr>
<td>UER</td>
<td>Upper East Region</td>
</tr>
<tr>
<td>UTM</td>
<td>Universal Transverse Mercator</td>
</tr>
<tr>
<td>WCD</td>
<td>World Commission on Dams</td>
</tr>
<tr>
<td>WEAP</td>
<td>“Water Evaluation And Planning” system</td>
</tr>
<tr>
<td>WGS</td>
<td>World Geodetic System</td>
</tr>
<tr>
<td>WUA</td>
<td>Water Users Association</td>
</tr>
</tbody>
</table>
1.0 Introduction

In periods of droughts, the local population in most semi-arid environments relies highly on small reservoirs\(^1\) to sustain their livelihoods (Liebe et al, 2005; Poolman, 2005; Balazs, 2006). Water stored in these reservoirs allow for all-year-round irrigated agriculture for most farmers and ensures that domestic water shortages are reduced to the barest minimum during dry periods. In order to manage the water effectively for competing uses, the actual storage of these reservoirs need to be accurately estimated. Landsat imagery has been recently used to delineate some of the reservoirs in the Upper East region (UER) of Ghana, West Africa (Liebe et al, 2005). This was quite successful. During that study, the number; spatial distribution and storage volumes of reservoirs were estimated. However, the accuracy of the lateral delineation of these reservoirs needs further studies since it is paramount for its monitoring especially for purposes such as forecasting of crop failure in the dry seasons.

This research is focused on how radar images (ENVISAT-ASAR) can be used to provide year-round monitoring since Landsat images and other images obtained from optical sensors are mostly affected by cloud cover (van de Giesen, 2000; Xu et al., 2004; Liebe et al, 2005). Radar has the important advantage that it is independent of cloud cover (van de Giesen, 2000; Horritt and Mason, 2001; Herold et al, 2004) and so can be used to obtain day and night time imagery. Here, how a monthly regional inventory of storage in small reservoirs can be obtained is illustrated.

Chapter 1 gives the background, goals and the objectives of this research; Chapter 2 reports on the use of GIS and remote sensing in Water Resources and Hydrology and some techniques used to delineate reservoirs; Chapter 3 gives a brief background of the study area; Chapter 4 describes the materials and methods used for the extraction of the outlines of field and satellite reservoirs, discusses how the reservoirs were delineated and describes the data used for the analyses. The results/discussion and conclusion/recommendations for this research are given in Chapters 5 and 6 respectively.

1.1. Problem Statement

Given the limited availability of ground data and/or the time and cost involved in doing field measurements, can radar imagery be used to quantify the amount of water in a reservoir? Can this information be used to enhance decision making and management of small reservoirs?

1.2. Research Goal, Objectives and Questions

1.2.1 Research Goal
The goal of this research is to obtain a monthly inventory of storage in small reservoirs in the Upper East region of Ghana using radar images and to use this information to enhance decision making in water management.

---

\(^1\) Small Reservoirs are defined in this context as those with surface areas less than 100 hectares
1.2.2 Research Objectives
The specific objectives were to:

i. correlate the concept of remote sensing with issues of lateral accuracy in delineating small reservoirs using Landsat and ENVISAT ASAR (radar) imagery on the regional scale in the Upper East Region (UER).

ii. estimate the surface area of reservoirs using radar imagery and obtain their storage volume using an existing correlation between their surface areas and volumes.

iii. develop a GIS based map of the distribution of these reservoirs and their storage capacities.

iv. make an inventory of all possible sources of radar-based satellite images with coverage over the Upper East region of Ghana.

1.2.3 Research Questions
At the end of this research, it is expected that the following questions would be answered:

i. What is the lateral accuracy of reservoir surface area obtained through ENVISAT ASAR (radar) compared to ground measurements?

ii. How can reservoir states obtained from remote sensing be used to enhance decision making?

iii. What delineation techniques are available?

1.3. Hypothesis

There is a high correlation between surface areas of small reservoirs obtained from ENVISAT ASAR and that obtained from ground survey and this can be used for all-year round regional monitoring in the Upper East Region of Ghana.
2. GIS and Remote Sensing for Water Resources and Hydrology

GIS is a powerful tool for developing solutions for water resources such as assessing water quality, flood and watershed management on a local or regional scale (ESRI, 2007). “Modern Hydrologists rely on GIS technology to integrate various data and applications into one, manageable system” (ESRI, 2007) for uses such as: the delineation of basins and their drainage patterns, simulation of runoff, the determination of the risk of groundwater and surface water to contamination. Grover (2007), reports that over the last decade, the technological advancement of GIS has been a great asset to hydrological modelling.

Remote sensing data plays a key role in hydrology. “Area information instead of the usual point data (e.g. at rain gauges, evaporation pans, infiltrometers etc) obtained from remote sensing are of great advantage in hydrology” (Schultz, 1993). He emphasises the need for scientist who want to use remote sensing data to solve problems in hydrology to be mindful of the spatial and temporal resolution of the acquired data and the availability of the needed spectral bands for their analyses. Remote sensing is mainly applied in the following fields in hydrology: rainfall, evapotranspiration, soil moisture, groundwater, surface water, snow and ice, sediments as well as hydrological modelling (Schultz, 1993).

In recent hydrological modelling it has become necessary to merge data from remote sensing to other information such as: 1) the merging of landuse classification with soil maps in order to determine soil water storage maps and 2) the use of landuse data and DEM to develop “hydrologically similar units map” (Schultz, 1993). Another example is the prediction of flood hydrographs and spatial distribution of hydrological characteristics over a river basin by the use of a DEM, soil and landuse data within a GIS framework (de Smedt et al., 2004).

2.1. Delineation of reservoirs by Remote Sensing using Landsat and ENVISAT ASAR imagery

Pietroniro and Leconte, 2005 define remote sensing as the “science and art of obtaining information about an object, area, or phenomenon through the analyses of data acquired by a sensor that is not in direct contact with the target of investigation” while Elachi and van Zyl, 2006 simply define it as acquiring information about an object without any physical contact with the object under investigation. Radio waves, through the microwave, submillimeter, far infrared, near infrared, visible, ultraviolet, x-ray and gamma-ray regions of the electromagnetic spectrum are covered in most remote sensing techniques (Elachi and van Zyl, 2006).

According to Spaans (2006), satellite sensor transmissions are characterised by their:
- spectral coverage (band location)
- spectral resolution (band width)
- spectral dimensionality (number of bands)
- radiometric resolution (quantization)
- geometric resolution (pixel size on the surface)
- temporal resolution (repeatability in time)
These sensors can be active or passive. The active sensors such as ENVISAT ASAR emit their own electromagnetic energy (e.g. lasers (LIDAR) and microwave (RADAR)) to the investigated surface and sense back the reflected energy from the surface. On the contrary, passive sensors such as Landsat/TM do not emit their own energy but measure energy reflected/emitted to the sensor from the surface under investigation (Alberotanza, 2001). Most of the energy if not all, which are reflected by the investigated surface to the passive sensors is emitted from the sun (Solar illumination). This makes it difficult to obtain night-time images from Landsat/TM and other passive sensors. However Landsat has been used for a lot of applications because of its relatively easy processing procedure and wide coverage across the globe. The primary role of NASA’s Landsat is to provide global, high-resolution measurements of land surface and surrounding coastal regions (Spaans, 2006).

Since 1972, Landsat has provided researchers with data to monitor global environmental changes to enable them separate human-induced changes from natural changes (Quirk and Duval, 2002). Landsat has archived almost 2million scenes now (Landsat Newspaper, 2006). Quirk and Duval (2002) argue that Landsat has a high resolution to accurately measure the amount and origin of land cover changes unlike Coarse-resolution sensors like MODIS and AVHRR. They also argue that High-resolution commercial systems are valuable for validation but often do not provide sufficient global data to meet scientific monitoring needs like Landsat. Landsat has a spatial resolution of about 30m (Table 1) and a temporal resolution of 16 days. Its’ temporal resolution is better than ENVISAT- ASAR which is 35days with a spatial resolution of 30m.

The infrared, visible red and near-infrared bands found in Landsat/TM and other infrared satellite imagery is used to distinguish between land and water and map the extent of open water surface (Tøyra et al., 2002; Liebe et al., 2005). Basically Landsat data are either shown in true colour or false colour composites (Spaans, 2006). In Landsat ETM+, bands 4 to 7 (infrared) are used to distinguish between water and vegetation while band 3 (visible) helps distinguish between water and soils; this is due to the fact that the spectral reflectance curve of water is low whereas that for soils and healthy vegetation are higher (Liebe et al., 2005). Water; when not turbulent absorbs energy in the near-infrared and infrared wavelengths hence appear darker in the imagery whereas land and vegetation are seen as bright spots. The techniques used for the delineation of open water range from visual interpretation by density slicing and band-ratio-approaches (NDWI) to different methods of supervised and unsupervised classification (Liebe, 2002). Table 1 shows the features that can be easily identified by using the various bands in a Landsat image and Table 2 gives a list of some radar-based satellites with coverage over the UER. “The spectral reflectance patterns from surface waters are composed of three influencing parameters: Surface reflection, volume reflectance and bottom reflectance meaning that “it is affected by the presence and concentration of dissolved and suspended organic and inorganic material, and by the depth of the water body” (MATHER, 1999 as cited in Liebe, 2002; Jensen, 2007). This sometimes leads to misclassification of land covers or any other feature of interest.

“The spectral signature of a material may be defined in the solar-reflective region by its reflectance as a function of its wavelength” (Schowengerdt, 1997). Signatures of interest in other spectral regions include temperature and emissivity in the thermal infrared range and surface roughness in radar (Schowengerdt, 1997). Multispectral images help distinguish different materials easily since each material has its own spectral

Annor F.O.- Water Resources Management
signature. Although easy, it is not that straightforward since these signatures are most often foiled by a number of factors which includes; the materials natural variability, coarse radiometric resolution of many remote sensing systems and the modification of signatures by the atmosphere (Schowengerdt, 1997).

As mentioned earlier on, cloud cover and the presence of reeds and other suspended organic and inorganic materials on the surface of reservoirs make it difficult to distinguish between land and water using Landsat. This is the main driver for the use of ENVISAT ASAR imagery which is weather independent for this research work to determine whether it can fill in the gaps left by using Landsat imagery.

Table 1: Features that are best identified in the various bands of a Landsat image

| Band 1 | Visible blue (reflected) 30 m | Scattered by the atmosphere and illuminates material in shadows better. Blue penetrates clear water better than other colours - see the texture of/in the water along the shore. It is absorbed by chlorophyll, and so plants don't show up very brightly in this band. Still it is useful for soil/vegetation discrimination, forest type mapping, and identifying man-made features, such as the airport in the lower right area of the image. |
| Band 2: Visible green (reflected) 30 m | Penetrates clear water fairly well, and gives excellent contrast between clear and turbid (muddy) water. It helps find oil on the surface of water, and vegetation (plant life) reflects more green light than any other visible colour. Manmade features are still visible (note the airport). |
| Band 3 | Visible red (reflected) 30 m | Limited water penetration. It reflects dead foliage, but less live foliage with chlorophyll. It is useful for identifying vegetation types, soils, and urban (city and town) features. |
| Band 4 | Near Infrared (reflected) 30 m | IIR: Redder than red, but not visible) is good for mapping shorelines and biomass content. It is very good at detecting and analyzing vegetation. See how the fields that looked almost the same in bands 1, 2, or even 3 have changed dramatically in band 4. Note that the airport has darkened. |
| Band 5 | Mid-Infrared (reflected) 30 m | Even more red than NIR. Has limited cloud penetration and provides good contrast between different types of vegetation. It is also useful to measure the moisture content of soil and vegetation. It helps differentiate between snow and clouds. |
| Band 6 | Thermal Infrared (emitted) 60 m | Thermal IR, also called long-wavelength infrared (LWIR) “Sees” warm objects, useful to observe temperature and its variations, and some vegetation density, moisture, and cover type. This image has only 60-meter pixels, so it is not as sharp as the other images. |
| Band 7 | Mid-Infrared (reflected) 30 m | Has limited cloud penetration and provides good contrast between different types of vegetation (compare to vegetation in bands 4 and 5). It is also useful to measure the moisture content of soil and vegetation. It helps differentiate between snow and clouds. |
| PAN | Very High resolution visible scan |

[Source: adapted from Spaans, 2006]
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER

Table 2: Radar-based satellites with coverage over the Upper East Region of Ghana

<table>
<thead>
<tr>
<th>Radar</th>
<th>Sensor - Satellite</th>
<th>Sponsor</th>
<th>Lifespan</th>
<th>Spatial Resolution</th>
<th>Swath</th>
<th>Spectral Bands</th>
<th>Other Sensor Specs</th>
<th>Repeat Cycle</th>
<th>Pricing</th>
<th>Links</th>
<th>Web address</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERS-1</td>
<td>C-Band SAR</td>
<td>Europe</td>
<td>July 1991-March 2000</td>
<td>30m</td>
<td>100x100 km</td>
<td>C-Band (5.3GHz, WL=5.66cm) SAR VV Polarization</td>
<td>Interferometry possible</td>
<td>35 days</td>
<td>PRI product: 1600$Can /scene</td>
<td>Official ERS website</td>
<td><a href="http://earth.esa.int/ers/">http://earth.esa.int/ers/</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ESA archive search tool</td>
<td><a href="http://eoli.esa.int/servlets/template/welcome/entryPage.vm">http://eoli.esa.int/servlets/template/welcome/entryPage.vm</a></td>
</tr>
<tr>
<td>ERS-2</td>
<td>C-Band SAR</td>
<td>Europe</td>
<td>1995 - ongoing</td>
<td>30m</td>
<td>100x100 km</td>
<td>C-Band (5.3GHz, WL=5.66cm) SAR VV Polarization</td>
<td>Interferometry possible</td>
<td>35 days</td>
<td>PRI product: 1600$Can /scene</td>
<td>Official ERS website</td>
<td><a href="http://earth.esa.int/ers/">http://earth.esa.int/ers/</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ERS 1/2 interferometry</td>
<td><a href="http://earth.esa.int/services/esa_doc/doc_int.html">http://earth.esa.int/services/esa_doc/doc_int.html</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ESA archive search tool</td>
<td><a href="http://eoli.esa.int/servlets/template/welcome/entryPage.vm">http://eoli.esa.int/servlets/template/welcome/entryPage.vm</a></td>
</tr>
<tr>
<td>JERS-1</td>
<td>L-Band SAR</td>
<td>Japan</td>
<td>Feb. 1992-Oct. 1998</td>
<td>18x24m</td>
<td>75x75 km</td>
<td>C-Band (1275GHz, WL=23.5cm) SAR HH Polarization</td>
<td>Interferometry &amp; Stereoscopy possible (band 3 &amp; 4)</td>
<td>44 days</td>
<td>NK</td>
<td>Official JERS-1 website</td>
<td><a href="http://www.eorc.jaxa.jp/JERS-1/GFMP/index.html#AFR">http://www.eorc.jaxa.jp/JERS-1/GFMP/index.html#AFR</a></td>
</tr>
<tr>
<td>ERSAT-1</td>
<td>ASAR</td>
<td>ESA</td>
<td>May 2002</td>
<td>30, 150, 500m</td>
<td>5-406 km</td>
<td>C-Band ASAR (5.331GHz) Multi Pol Imagettes to ScanSAR</td>
<td>Interferometry possible, Alternating polarization: HH/VV or VV/HH or 25m pixels</td>
<td>35 days</td>
<td>PRI product: 1600$Can /scene</td>
<td>Official ESA website</td>
<td><a href="http://envisat.esa.int/dataproducts/asar/">http://envisat.esa.int/dataproducts/asar/</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ESA archive search tool</td>
<td><a href="http://eoli.esa.int/servlets/template/welcome/entryPage.vm">http://eoli.esa.int/servlets/template/welcome/entryPage.vm</a></td>
</tr>
<tr>
<td>Space Shuttle Endeavour</td>
<td>SRTM/SRTM</td>
<td>NIMA/NASA/ASI</td>
<td>February 2000</td>
<td>30m, ±16 m absolute vertical height accuracy at the 90% confidence level</td>
<td>About 50 km</td>
<td>X (6.1 cm), C (5.8 cm) Bands</td>
<td>C-Band IFSAR Generate DEM</td>
<td>11 days total</td>
<td>$60.00 per DVD &amp; Electronic download is Free</td>
<td>USGS website</td>
<td><a href="http://srtm.usgs.gov/data/obtainingdata.php">http://srtm.usgs.gov/data/obtainingdata.php</a></td>
</tr>
</tbody>
</table>

NK = Not Known

[Source: adapted from ARSIST, 2004]
2.2. ENVISAT ASAR data description

ENVISAT ASAR is a follow up of ERS-1 and ERS-2 (SIMP, 2004). It is one of the satellites that have been launched most recently. Figure 1 shows some of the most recent satellites launched.

The ENVISAT ASAR is on board the ENVISAT-1 satellite (shown in Figure 2). This satellite is owned by ESA and was launched from Kourou in French Guiana on 1\textsuperscript{st} March, 2002 (ESA, 2007).
The ENVISAT ASAR is operated at the C-band (5.331GHz) (SIMP, 2004). It is a high resolution imaging radar which can be operated in 5 distinct Measurement Modes, Image Mode (IM), Alternating Polarization Mode (AP), Wide Swath Mode (WS), Global Monitoring Mode (GM), and Wave Mode (WV) (EPS, 2004). The beam elevation steerage capability of the ENVISAT ASAR allows several different image swaths to be used within each mode, providing swath coverage of over 400km wide using ScanSAR techniques at medium resolution (150m) (EPS, 2004; SIMP, 2004).

The different swaths that can be obtained in each of the modes are given in Table 3 and their technical summary given in Table 4. In the alternating polarizations mode, scenes can be imaged simultaneously in two polarization; co-polarization (HH or VV) or cross polarization (HV or VH) due to the fact that transmit and receive polarizations can be selected (SIMP, 2004). This is anticipated to have an advantage over single polarized images.
Table 3: Nominal ASAR Characteristics

<table>
<thead>
<tr>
<th>ASAR Image Mode</th>
<th>VV or HH polarization images from any of 7 selectable swaths. Swath width between approximately 56 km (swath 7) and 100 km (swath 1) across track. Spatial resolution of approximately 30 m (for Precision product).</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASAR Alternating Polarization Mode</td>
<td>Two co-registered images per acquisition, from any of 7 selectable swaths. HH/VV HH/HV or VV/VH polarization pairs possible. Spatial resolution of approximately 30 m (for Precision product).</td>
</tr>
<tr>
<td>ASAR Wide Swath Mode</td>
<td>400 km by 400 km wide swath image. Spatial resolution of approximately 150 m by 150 m for nominal product. VV or HH polarization.</td>
</tr>
<tr>
<td>ASAR Global Monitoring Mode</td>
<td>Spatial resolution of approximately 1000 m in azimuth by 1000 m in range for nominal product. Up to a full orbit of coverage. HH or VV polarization.</td>
</tr>
<tr>
<td>ASAR Wave Mode</td>
<td>A small imagette (dimensions range between 10 km by 5 km to 5km by 5km) is acquired at regular intervals of 100 km along track. The imagette can be positioned anywhere in an image mode swath. Up to two positions in a single swath or in different swaths may be specified, with acquisitions alternating between one and the other (successive imagettes will hence have a separation of 200 km between acquisitions at a given position). HH or VV polarization may be chosen. Imagettes are converted to wave spectra for ocean monitoring.</td>
</tr>
</tbody>
</table>

[Source: adapted from EPS, 2004]

Table 4: Technical Summary of ASAR Alternating Polarization Mode

<table>
<thead>
<tr>
<th>Image Swath</th>
<th>Swath Width (km)</th>
<th>Ground position from nadir (km)</th>
<th>Incidence Angle Range</th>
<th>Worst Case Noise Equivalent Sigma Zero</th>
</tr>
</thead>
<tbody>
<tr>
<td>IS1</td>
<td>105</td>
<td>187-292</td>
<td>15.0-22.9</td>
<td>-20.4</td>
</tr>
<tr>
<td>IS2</td>
<td>105</td>
<td>242-347</td>
<td>19.2-26.7</td>
<td>-20.6</td>
</tr>
<tr>
<td>IS3</td>
<td>82</td>
<td>337-419</td>
<td>26.0-31.4</td>
<td>-20.6</td>
</tr>
<tr>
<td>IS4</td>
<td>88</td>
<td>412-500</td>
<td>31.0-36.3</td>
<td>-19.4</td>
</tr>
<tr>
<td>IS5</td>
<td>64</td>
<td>490-555</td>
<td>35.8-39.4</td>
<td>-20.2</td>
</tr>
<tr>
<td>IS6</td>
<td>70</td>
<td>550-620</td>
<td>39.1-42.8</td>
<td>-22.0</td>
</tr>
<tr>
<td>IS7</td>
<td>56</td>
<td>615-671</td>
<td>42.5-45.2</td>
<td>-21.9</td>
</tr>
</tbody>
</table>

[Source: adapted from EIPS, 2007]
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER
3. Study area - The Upper East region of Ghana (UER)

The Ghana Poverty Reduction Strategy Paper (2005) identifies Northern Ghana as the number one poverty endemic area in Ghana. The Upper East region (shown in Figure 3) is located in the northeastern corner of this Country. Ghana shares borders with Burkina Faso to the north, Togo to the east and Ivory Coast to the West. The UER is made up of 8 districts; Bolgatanga, Bawku East, Bawku West, Builsa, Bongo, Kassena/Nankana, Garu-Tempante and Talensi-Nabdam districts and covers about 3.7% (8842 square kilometers) of the Landmass of Ghana. Its’ regional capital is Bolgatanga. The UER’s mean population density is 125inhabitants/km$^2$ and in the rural areas 100inhabitants/km$^2$ (IFAD, 2007). Crop and livestock (Cattle) farming is the major occupation of the local populace. Crops cultivated include rice, maize, millet, sorghum and vegetables. The geography is primarily savanna grassland. The Upper East Region of Ghana is underlain predominantly by intruded granites and Pre-Cambrian Rocks of the Birrimian and Tarkwaian series (Liebe, 2002). This region happens to be one of the “driest” regions in the country. Rainfall over the past 40 years has averaged 1044mm/a which is suitable for a single wet season crop (IFAD, 2007) with a mean annual temperature of 27.8°C and a mean annual rate of pan evaporation of 2540mm/a (Gyau-Boakye and Tumulto, 2006). The rainfall distribution is bimodal. Access to water for livestock farming, irrigation and other domestic uses during the dry season is hence a major concern for the populace.

![Figure 3: The Upper East Region of Ghana, within the Volta Basin](Source: adapted from Liebe et al., 2005)
3.1. Water Balance in the UER

Acheampong (1988) as cited in Liebe (2002) deducts a water budget (Shown in Figure 4) from potential evaporation and rainfall data as follows: the surplus water of the first two wet months mainly recharges the soil moisture. As it reaches a saturation threshold value (102mm), most of the rainfall is disposed off as runoff. In Navrongo, soils are therefore at field capacity from August to September and begin to build up soil moisture deficit from October onwards. This is because; during these periods precipitation falls below the potential evaporation. This continues until June-July when precipitation rises above potential evaporation again and inhibits agricultural production (Liebe, 2002). The need therefore arises for irrigation especially in the dry seasons to improve crop yield. Small reservoirs help in this regard.

Figure 4: Water Budget for Navrongo
(Source: adapted from Acheampong, 1988 as cited by Liebe, 2002)

3.2. Importance of small reservoirs in the UER

In 1986 it was estimated that 67% of small holders (those farming less than 1.6ha and in the UER 2.4ha) in Ghana were living in poverty thus below the Basic Need Income\(^2\) (BNI) (IFAD, 2007). The LACOSREP in 1998 therefore saw the need to provide some farm families with adequate supply of irrigation water. This was done on the basis of holding a 2ha or less farmland and having no alternative form of employment. The project was to ensure that 350ha of existing and 205ha of newly irrigated lands were supplied with water through the rehabilitation of existing small dams or reservoirs and the formation and strengthening of WUAs. This was to help alleviate the poverty level of the rural populace (who constitute about 87% of the total population) in the UER (IFAD, 2007).

The very short wet period in the UER is marked by confusing fluctuations in arrival time, duration and intensity of rainfall. “This, together with the poor water retention capacity of the soils, cause large inter-year variations in the production potential” (IFAD, 2007). The reliance of peasant farmers on small reservoirs in this region is very enormous. Most often it is the only water available for watering their crops during the dry season. The use of ground water for farming has not yet been extensively explored

\(^2\) BNI is the “income level below which a minimal nutritionally adequate diet plus essential non-food requirements is not affordable” (FAO, 1991)
in UER. This calls for better reservoir management and operation so that farmers can have better yields hence improve their livelihoods. The reservoirs in this region store water in the wet season (June-October) and make them available in the dry season (November – April).

Keller et al. (1998) reports that “One-third of the developing world will face severe water shortages in the twenty-first century even though large amounts of water will continue to annually flood out to sea from water-scarce regions. The problem is that the sporadic, spatial and temporal distribution of precipitation rarely coincides with demand. Whether the demand is for natural processes or human needs, the only way water supply can match demand is through storage” This emphasizes the importance of storage in (small) reservoirs in semi-arid environments.

Small reservoirs also recharge the ground water aquifer. Most villages and small towns in the UER rely solely on groundwater for drinking purposes.

Accurate estimation of the storage volume of reservoirs at various points in time (especially monthly inventory) is crucial for effective planning and management. Knowledge of the storage volume will enable ICOUR, IDA, MOFA and other agencies advise farmers on the type of crops to grow at various seasons. Most of these reservoirs in the UER were built by different agencies and mainly managed by MOFA, IDA and the district assemblies. They have lost track of some of these reservoirs and are also unable to continuously monitor them because they rely on ground survey to estimate the storage volume which is time consuming and expensive.

This research explains how satellite imagery from ENVISAT ASAR can be used to monitor the water storage in small reservoirs all-year round.
4. Lateral delineation of reservoirs

For this research, six ENVISAT SLC alternating polarization mode data were acquired from ESA. The description of the data is given in Table 5.

Table 5 Description of data used in this research

<table>
<thead>
<tr>
<th>No.</th>
<th>Sensor</th>
<th>Product</th>
<th>Orbit</th>
<th>Track</th>
<th>Swath</th>
<th>Date</th>
<th>Spatial Resolution (square pixel) - m</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ASAR/AP</td>
<td>ASA_APH</td>
<td>25377</td>
<td>273</td>
<td>I1</td>
<td>6/1/2007</td>
<td>12</td>
</tr>
<tr>
<td>2</td>
<td>ASAR/AP</td>
<td>ASA_APH</td>
<td>25420</td>
<td>316</td>
<td>I4</td>
<td>9/1/2007</td>
<td>10</td>
</tr>
<tr>
<td>3</td>
<td>ASAR/AP</td>
<td>ASA_APH</td>
<td>25606</td>
<td>1</td>
<td>I1</td>
<td>22/01/07</td>
<td>12</td>
</tr>
<tr>
<td>4</td>
<td>ASAR/AP</td>
<td>ASA_APH</td>
<td>25649</td>
<td>44</td>
<td>I2</td>
<td>25/01/07</td>
<td>11</td>
</tr>
<tr>
<td>5</td>
<td>ASAR/AP</td>
<td>ASA_APH</td>
<td>25692</td>
<td>87</td>
<td>I4</td>
<td>28/01/07</td>
<td>10</td>
</tr>
<tr>
<td>6</td>
<td>ASAR/AP</td>
<td>ASA_APH</td>
<td>25735</td>
<td>130</td>
<td>I7</td>
<td>31/01/07</td>
<td>7.5</td>
</tr>
</tbody>
</table>

4.1. Extracting the outline of reservoirs with ENVISAT ASAR

The 2006 Verkeer en waterstaat report on Land and water detection, acknowledges two unsatisfactory attempts to extract the land/water boundary from satellite observations; Koppen & Wang (ERSWAD project, NRSP-2 92-20) and van Koppen et al. (interferometric shoreline mapping, USP-2 99-24). Koppen & Wang used the pixel intensity of the image for the classification of land and water whilst Koppen et al. used the coherence between SAR images. The unsatisfactory results were attributed to the fact that intensities of images were highly variable hence the method had a limited applicability whereas using the coherence resulted in a poor resolution because coherence is a non-local quantity.

In this study, the magnitude of the polarization channels (C-HH and C-HV) was used for the classification of land and water. The channels were also combined to study their ability to enhance the Land/Water contrast in the images.

4.1.1 Processing of images

The SLC images were imported into Erdas imagine. Radar images are often foiled with noise; this happens when the waves received from the target area are out of phase. “The waves emitted by active sensors travel in phase and interact minimally on their way to the target area. After interaction with the target area, these waves are no longer in phase. This is because of the different distances they travel from targets, or single versus multiple bounce scattering” (Erdas field guide, 2005). The noise shows up as areas of dark and light pixels. This happens with both microwave and millimeter wave sensing systems.

In reducing speckles noise in the radar images, the gamma-map filter was used. A lot of filters like Lee, Lee-Sigma and Frost assume that the noise is Gaussian distributed. Studies conducted recently especially on natural vegetated areas have proven that the
distribution is rather gamma. The Maximum A Posteriori (MAP) filter assumes that the original pixel Digital Number (DN) lies between the local average and the degraded (actual) pixel DN. It then attempts to estimate the original pixel DN based on this assumption. The algorithm is built on the cubic equation given by:

\[
\hat{I}^3 - \hat{I}^2 + \sigma(\hat{I} - DN) = 0
\]

Where:

- \(\hat{I}\) = Sought Value
- \(\bar{I}\) = Local Mean
- \(\sigma\) = Original image Variance
- \(DN\) = Input Value

(Source: Frost et al, 1982 as cited in Erdas field guide, 2005)

To reduce the speckle noise, the images were filtered with 7x7 followed by a 5x5 window gamma-map adaptive filter. Other filters such as Mean, Median, Lee-sigma and Local region did not produce satisfactory results in terms of speckle reduction and detail preservation.

After filtering the images, The UTM Zone 30N coordinates on the WGS84 ellipsoid was used to geocode the images. This was followed by image-image co-registration. Figure 5 shows the unfiltered and filtered images of the same scene.

![Unfiltered and filtered images](image)

(a) Unfiltered      (b) filtered

**Figure 5** C-HH backscatter of a SLC image, 31st January, 2007

The images were then classified using a hybrid (a combination of unsupervised and supervised) maximum likelihood classification with training sites verified with ground truth data in Erdas Imagine. The maximum likelihood classifier calculates for each class the probability of a cell belonging to that class given its attribute values. The cell is then assigned to the class with the highest probability. The images were georeferenced in ArcMap using 2nd Order Polynomial (affine) transformation with an RMS error of about 20m with 15 ground control points (GCP). Figure 6 shows an Ungeoreferenced and a georeferenced image (the images are unclassified and are from the same scene).
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER

Figure 6: Ungeoreferenced and georeferenced image scenes of 31st January, 2007

The magnitude of the C-HH or in some cases the C-HV polarimetric channel was used to delineate the reservoirs. A combination of the two channels especially when one is good and the other bad did not yield good results. The delineation was done by an on-screen digitization in ArcMap. The detail of the image processing is given in Appendix A.

4.2. Extracting the outline of reservoirs with ground truth data

Ground truthing was carried out from 31st January to 7th February, 2007 at the time of overpass of the satellite. Forty-two (42) dams/dugouts (shown in figure 7) were visited but the outlines of 40 reservoirs were obtained with a Garmin 76 GPS instrument (with accuracy of < 15m RMS 95% typical) since the remaining two dams were inaccessible because the dam walls were fenced and the other had very thick bushes around the reservoir so it was difficult to go round the reservoir with the GPS.

Figure 7: Map showing the Locations of Dams/dugouts visited during the field work in the UER

The month of February is within the dry period (November-April) hence the reservoirs were not at maximum capacity at the time of visit. Some of the reservoirs were free of...
reeds; however most of them had reeds at the tail end with some having more than 40% of their surface area covered with reeds. Figure 8 shows a reservoir with reeds on its surface.

Figure 8: Winkogo dam with reeds on the surface of the reservoir

The outline of the reeds on the surface of the reservoirs was taken with the GPS by the use of a rubber boat. The data stored on the GPS was imported into GPS Trackmaker13. This was used to import and convert the GPS data into text formats so it could be read by ArcCatalog. The Easting(X), Northern (Y) and Elevation (Z) data in text format were converted into features (geocoded shape (points) files) in ArcCatalog. The points were connected together to form polygons using Xtoolspro4.1 in ArcMap9.2. The surface areas and perimeter were calculated using Xtoolspro4.1. The same results could have been obtained using the “calculate geometry” function in the attribute table in ArcMap9.2. Details of how the polygons were created are given in Appendix B.
5. Results and Analysis

5.1. Field - Satellite Surface area correlation

Table 6 shows the results obtained from field survey and the ones delineated from satellite images.

Table 6: Comparison of Field surface area with satellite area of reservoirs

<table>
<thead>
<tr>
<th>S/N</th>
<th>Name</th>
<th>Area$_{sat}$ (hectares)</th>
<th>Area$_{field}$ (hectares)</th>
<th>DAI</th>
<th>NDIA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Asunia</td>
<td>1.83</td>
<td>2.07</td>
<td>0.12</td>
<td>0.06</td>
</tr>
<tr>
<td>2</td>
<td>Baare</td>
<td>9.46</td>
<td>8.40</td>
<td>-0.13</td>
<td>-0.06</td>
</tr>
<tr>
<td>3</td>
<td>Binechoro</td>
<td>2.37</td>
<td>3.82</td>
<td>0.38</td>
<td>0.23</td>
</tr>
<tr>
<td>4</td>
<td>Bugri</td>
<td>9.78</td>
<td>10.86</td>
<td>0.10</td>
<td>0.05</td>
</tr>
<tr>
<td>5</td>
<td>Dua</td>
<td>5.07</td>
<td>4.55</td>
<td>-0.11</td>
<td>-0.05</td>
</tr>
<tr>
<td>6</td>
<td>Kalivio</td>
<td>1.65</td>
<td>2.91</td>
<td>0.44</td>
<td>0.28</td>
</tr>
<tr>
<td>7</td>
<td>Kamega</td>
<td>10.21</td>
<td>11.07</td>
<td>0.08</td>
<td>0.04</td>
</tr>
<tr>
<td>8</td>
<td>Kongo</td>
<td>6.90</td>
<td>5.98</td>
<td>-0.15</td>
<td>-0.07</td>
</tr>
<tr>
<td>9</td>
<td>Lamboya</td>
<td>20.71</td>
<td>20.08</td>
<td>-0.03</td>
<td>-0.02</td>
</tr>
<tr>
<td>10</td>
<td>Pomaaba</td>
<td>27.43</td>
<td>23.92</td>
<td>-0.15</td>
<td>-0.07</td>
</tr>
<tr>
<td>11</td>
<td>Shergu</td>
<td>3.82</td>
<td>4.42</td>
<td>0.14</td>
<td>0.07</td>
</tr>
<tr>
<td>12</td>
<td>Teshie</td>
<td>4.34</td>
<td>3.39</td>
<td>-0.28</td>
<td>-0.12</td>
</tr>
<tr>
<td>13</td>
<td>Widnaba</td>
<td>7.32</td>
<td>6.56</td>
<td>-0.11</td>
<td>-0.05</td>
</tr>
<tr>
<td>14</td>
<td>Winkogo</td>
<td>0.81</td>
<td>3.66</td>
<td>0.78</td>
<td>0.64</td>
</tr>
<tr>
<td>15</td>
<td>Worricamo</td>
<td>14.25</td>
<td>11.38</td>
<td>-0.25</td>
<td>-0.11</td>
</tr>
<tr>
<td>16</td>
<td>Yirdongo</td>
<td>15.83</td>
<td>14.15</td>
<td>-0.12</td>
<td>-0.06</td>
</tr>
<tr>
<td>17</td>
<td>Zibila</td>
<td>5.24</td>
<td>10.86</td>
<td>0.52</td>
<td>0.35</td>
</tr>
<tr>
<td>18</td>
<td>Zuarungu</td>
<td>1.03</td>
<td>1.43</td>
<td>0.28</td>
<td>0.16</td>
</tr>
</tbody>
</table>

The Deviation Area Index (DAI) adapted from Sawunyama et al. (2005) and the Normalized Difference Area Index (NDAI) adapted from Liebe (2002) was used to compare the satellite surface area to the field surface area.

The formulae are given below:

\[ NDAI = \frac{(Area_{field} - Area_{sat})}{(Area_{field} + Area_{sat})} \]  \hspace{1cm} 2

\[ DAI = \frac{(Area_{field} - Area_{sat})}{Area_{field}} \]  \hspace{1cm} 3

The NDAI value lies between -1 and 1 with values close to zero giving the best linear fit between the surface areas obtained from field and satellite. Values increasing to both
extremes indicate increasing deviation between Area_f and Area_s. A negative value implies that Area_f < Area_s and vice versa.

Sawunyama et al. (2005) expressed the difference between Area_f and Area_s as a fraction of the field area. The DAI values also lie between -1 and 1, with values close to 0 giving the best linear fit between field area and satellite area, values increasing to both extremes indicates increasing deviation between Area_f and Area_s. A negative value implies that Area_f < Area_s and vice versa.

The results obtained from the DAI and NDAI shows that there is a very good linear fit between these two areas. A linear regression between Area_f and Area_s gave at 95% confidence interval (p<0.05), a Pearson correlation coefficient (R^2) of 0.9 when the intercept of the trend line was set to zero (Appendix C). This statistical analysis was done to develop an equation that expresses the area obtained from the satellite images as a percentage of the ones obtained from field. As shown in figure 9 the correlation between the field area and satellite is given by:

\[ Area_{field} = 0.932 Area_{sat} \]  

![Figure 9: Correlation between field surface area and satellite surface area](image)

The correlation was validated using three reservoirs. There was a close fit between the modeled area from the satellite and the area obtained from field measurements. The results are shown in table 7. (See Appendix C for statistical analysis)

<table>
<thead>
<tr>
<th>S/N</th>
<th>Name</th>
<th>Area_{sat} (ha)</th>
<th>Area_{field} (ha)</th>
<th>Area_{modelled} (ha)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Gamburugu</td>
<td>2.43</td>
<td>3.67</td>
<td>2.27</td>
</tr>
<tr>
<td>2</td>
<td>Samboligu</td>
<td>1.31</td>
<td>1.48</td>
<td>1.22</td>
</tr>
<tr>
<td>3</td>
<td>Namool</td>
<td>1.58</td>
<td>1.32</td>
<td>1.47</td>
</tr>
</tbody>
</table>
The following deductions were made from the results:

1. Equation 4 implies that the satellite images overestimated the areas of the reservoirs (thus using the field area as a benchmark) by about 7%. This could be attributed to the following reasons:

   i. The maximum likelihood classifier tends to over classify the area covered with water signatures with relatively large values in their covariance matrix. Covariance measures the tendencies of data file values in the same pixel, but in different bands, to vary with each other with respect to the means of their respective bands. This implies that if there is large dispersion of the pixels in a cluster/training site, then the covariance matrix of that signature will contain large values and will lead to misclassification (Erdas field guide, 2005). An example of an over classified water boundary is shown in figure 10. The shaded area (dark) is the area classified as water in the satellite image and the area enclosed within the polygon is the outline obtained from the field. The very bright areas are vegetation. The area behind the dam wall is a farmland and therefore appears bright.

   ![Figure 10: Over classified Kongo reservoir](image)

   ii. the difficulty in determining exactly where the shoreline is for both the fieldwork and the maximum likelihood classifier in the image analysis. In the field work an area filled with water of depth less than 2cm from the water/land boundary was taken to be the shoreline. For the classifier, land area close to the shoreline was sometimes classified as water.

2. From Table 6 it could be seen that although the reasons given in 1) above holds, some of the reservoirs had $\text{Area}_{\text{field}} > \text{Area}_{\text{sat}}$. As can be seen in the field and satellite area graph (Figure 9), Zibila, which is the point circled had its satellite area almost being half that obtained on field. This was due to the fact that there
were reeds/dense vegetation on the surface of these reservoirs. If these reeds were at the middle of the reservoir, as some were, then it would not have matter much since we could still identify that area to be part of the reservoir. But in cases where the reeds were at the tail-end or at the edges it was a big problem. This was because the area covered by the reeds at the edges was now classified as land/vegetation and not water. An example is Winkogo which had a lot of reeds on its surface as already shown in figure 8 above which classified about 78% of the water as land/vegetation. An example of a reservoir where Area_{field} > Area_{sat} is shown in figure 11. The shaded area (dark) is the area classified as water in the satellite image and the area enclosed within the polygon is the outline obtained from the field. In the figure, one can see that the areas at the tail-end are classified as vegetation instead of water.

![Figure 11: under classified Kamega reservoir](image)

3. Results obtained from earlier studies using Landsat by Liebe (2002) gave a correlation between field surface area and satellite surface area as:

\[ Area_{field} = 0.9366 \times Area_{sat} - 0.7746 \]

This was not very different from the one obtained from this study. However, he could not clearly explain the reasons why the satellite images over estimated the surface areas of the reservoirs since the time of his field work was in 2002 and the overpass of the satellite was in 1999. However, this research confirms that satellite images most often over estimate the area extents of reservoirs, and areas covered with dense carpet of floating vegetation are not classified as water by Landsat nor ENVISAT ASAR but as vegetation.
5.2. Surface area – volume correlation

A study carried out in the Upper East of Ghana by Liebe et al. (2005) found a correlation between the surface area of reservoirs and their storage volume as

\[
\text{Volume}_{\text{reservoir}} = 0.00857 \times \text{Area}_{\text{sat}}^{1.4367} \ (m^3)
\]

This formula was used to estimate the actual volume of water stored in the reservoirs. The correlation was established from a bathymetrical analysis carried out in 2002. The surface area used, was the one obtained using equation 4 and the surface areas obtained from the satellite imagery. The resulting surface areas were named Estimated Area\text{field}.

The result is presented in Table 8. The report of WCD (2000) says that about 0.5-1% of the total fresh water storage capacity of existing dams is lost each year to sedimentation in both large and small reservoirs worldwide. However it was assumed in the volume calculation for this study that the difference in the level of sedimentation from 2002 to 2007 has not changed so much to affect the correlation between reservoir volume and surface area. Practically there might be some sedimentation but also some dredging since the inhabitants take sand /silt from these reservoirs for construction purposes. The overall effect of this can therefore be marginalised to simplify the volume calculations. An example of a five-year consecutive no-change-in-sediment-yield for a flood-control reservoir in Oregon, USA is shown in figure 12 to support the argument that it is a valid assumption.

![Figure 12: Variation in sediment yield (tons/km²/year) over a 50-year record for Dorena Lake](Source: Ambers, 2001)
Table 8: Volume of reservoir estimated from satellite imagery

<table>
<thead>
<tr>
<th>S/N</th>
<th>Name of Reservoir</th>
<th>Perimeter (m)</th>
<th>Area_{sat} (hectares)</th>
<th>Estimated Area_{field}</th>
<th>Volume (ha-m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Asunia</td>
<td>1013</td>
<td>1.83</td>
<td>1.70</td>
<td>1.03</td>
</tr>
<tr>
<td>2</td>
<td>Baare</td>
<td>1965</td>
<td>9.46</td>
<td>8.81</td>
<td>10.91</td>
</tr>
<tr>
<td>3</td>
<td>Binechoro</td>
<td>1069</td>
<td>2.37</td>
<td>2.21</td>
<td>1.50</td>
</tr>
<tr>
<td>4</td>
<td>Bugri</td>
<td>2886</td>
<td>9.78</td>
<td>9.12</td>
<td>11.45</td>
</tr>
<tr>
<td>5</td>
<td>Dua</td>
<td>1133</td>
<td>5.07</td>
<td>4.72</td>
<td>4.45</td>
</tr>
<tr>
<td>6</td>
<td>Kalivio</td>
<td>638</td>
<td>1.65</td>
<td>1.53</td>
<td>0.88</td>
</tr>
<tr>
<td>7</td>
<td>Kamega</td>
<td>1412</td>
<td>10.21</td>
<td>9.52</td>
<td>12.18</td>
</tr>
<tr>
<td>8</td>
<td>Kongo</td>
<td>1581</td>
<td>6.90</td>
<td>6.43</td>
<td>6.94</td>
</tr>
<tr>
<td>9</td>
<td>Lamboya</td>
<td>2535</td>
<td>20.71</td>
<td>19.30</td>
<td>33.63</td>
</tr>
<tr>
<td>10</td>
<td>Pornaaba</td>
<td>3872</td>
<td>27.43</td>
<td>25.56</td>
<td>50.36</td>
</tr>
<tr>
<td>11</td>
<td>Sherigu</td>
<td>1168</td>
<td>3.82</td>
<td>3.56</td>
<td>2.97</td>
</tr>
<tr>
<td>12</td>
<td>Teshie</td>
<td>1044</td>
<td>4.34</td>
<td>4.04</td>
<td>3.56</td>
</tr>
<tr>
<td>13</td>
<td>Widnaba</td>
<td>1379</td>
<td>7.32</td>
<td>6.82</td>
<td>7.54</td>
</tr>
<tr>
<td>14</td>
<td>Winkogo</td>
<td>513</td>
<td>0.81</td>
<td>0.76</td>
<td>0.32</td>
</tr>
<tr>
<td>15</td>
<td>Worricambo</td>
<td>2540</td>
<td>14.25</td>
<td>13.28</td>
<td>19.66</td>
</tr>
<tr>
<td>16</td>
<td>Yirdongo</td>
<td>2597</td>
<td>15.83</td>
<td>14.75</td>
<td>22.86</td>
</tr>
<tr>
<td>17</td>
<td>Zibila</td>
<td>2253</td>
<td>5.24</td>
<td>4.88</td>
<td>4.67</td>
</tr>
<tr>
<td>18</td>
<td>Zuarungu</td>
<td>563</td>
<td>1.03</td>
<td>0.96</td>
<td>0.45</td>
</tr>
</tbody>
</table>

5.3. Monthly Inventory of Storage in reservoirs
Two ENVISAT ASAR satellite imagery captured on 14th July, 2005 and 18th August, 2005 were used to determine the volume of water stored in seven selected reservoirs for two consecutive months. The result is presented in Figure 13.

Figure 13: Reservoir storage in July, 2005 and August, 2005
An explanation for the varying percentage change in volume from reservoir to reservoir was out of scope of this research. The volumes were estimated to show that storage in reservoirs could be monitored on a monthly basis (all year-round monitoring). However the following could be reasons for the differences in volume change:

i. different water usage in the various reservoirs for purposes such as irrigation, drinking water for animals (cattle, donkey), domestic uses (washing, cleaning), for construction (building) etc.
ii. the structural state of the reservoirs (that is whether there is leakage or not in the dam wall)
iii. the level of siltation in the dams as a result of their time of construction and whether they are often dredged or not

In the next chapter, some conclusions are drawn based on the results obtained and the literature studies carried out.
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER
6. Conclusion and Recommendation

6.1. Specific Conclusion
The following conclusions are drawn from this research

1) There is a very good linear correlation between the Surface Area of a reservoir obtained on the field and that from satellite (radar) images;
\[ \text{Area}_{\text{field}} = 0.932 \text{Area}_{\text{sat}} \quad (R^2 = 0.90) \]

2) All year-round regional monitoring of reservoir storage volume in the UER can be easily carried out using radar-based remote sensing and GIS

3) Reeds which can be found in the shallow tail-ends of reservoirs, can not be readily distinguished from the surrounding vegetation by both Landsat and Envisat ASAR imagery

4) Landsat and ENVISAT ASAR tend to over estimate the lateral extents of reservoirs by about 7%.

5) The Dual polarization channel of the ENVISAT ASAR is optimal since sometimes the C-HH backscatter gives a better land/water contrast than the C-HV and other times vice versa due to wind conditions

6) Although dual polarization of the SLC ENVISAT ASAR is optimal it is less useful to combine C-HH and C-HV channels especially when on is good and the other bad since it does not enhance the land/water contrast as compared to using only one channel

7) Due to the fact that the volume of water can be easily estimated on a monthly basis using radar imagery, the results obtained can be used as inputs in open source water allocation and water resources planning models such as WEAP and WAFLEX and other commercial software. This will enhance decision making

6.2. General Conclusion

Remote sensing is a quick and cheap way of obtaining more information at very high temporal and spatial scales at almost no running cost as compared to traditional methods of ground survey which is time consuming and labour intensive. Nevertheless, remote sensing requires quite a huge start up cost in terms of training experts to use GIS and remote sensing application software, computer hardware requirements and acquisition of satellite images.

Remote sensing and GIS data to a large extent overcomes the difficulty in the collection, transfer and sharing of data in developing countries. Recent application of remote sensing for the determination of evapotranspiration and rainfall from Global Climate Models coupled with land cover changes and surface level measurements using Light Detection and Ranging (LIDAR) will make it much easier to determine the water balance over large areas at smaller temporal resolution at very low running cost. The use of this technology will enhance the efficient management of reservoirs for crop productions hence alleviate poverty especially in semi-arid environments.
6.3. Recommendation

Since ENVISAT ASAR and Landsat are both not able to detect water with reeds on its surface, the newly launched satellite, ALOS could be used to determine whether it fills this gap.

This approach should be used in other semi-arid environments with fairly uniform geomorphology and topography since it is a quick way to monitor the storage volume in reservoirs. This can also help monitor water use by riparian countries and enhance compliance to treaties for conflict resolution.

It was realised from this study that the processing of images require very high computer specification. To apply this technique using ENVISAT-ASAR, it is recommended to use a computer with at least the following specifications or higher to speed up processes. (See Appendix D for system specifications).
References


EPS (2004), Vol. 8: ASAR Products Specifications

ESA (2007), Envisat still going strong after five successful years, News. (Available at http://www.esa.int/esaCP/SEM129N0LYE_index_0.html) [Accessed online: 12/03/07]


Erdas Field Guide (2005), Leica Geosystems.
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER

FAO (1991), the development of aquaculture and culture based fisheries in Ghana: the social and cultural contexts, corporate document repository. (Available at http://www.fao.org/docrep/field/003/AC107E/AC107E00.HTM) [Accessed online: 21/03/07]


Grover, S. (2007), Perspectives of GIS modelling in hydrology. (Available at http://www.gisdevelopment.net/application/nrm/water/surface/watsw0004.htm) [Accessed online: 21/03/07]


Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER


Sawunyama, T., A. Senzanje, A. Mhizha (2005), Estimation of Small Reservoir Storage Capacities in Limpopo River Basin Using Geographical Information Systems (GIS) and Remotely Sensed Surface areas: Case of Mzingwane Catchment, Physics and Chemistry of the earth, 31, issue 15-16, 935-943


Annor F.O.-Water Resources Management
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER

L- and C-band radar in *Remote Sensing and Hydrology 2000* (Proceedings of a symposium held at Santa Fe, New Mexico, USA, April 2000). IAHS Publ. no. 267


APPENDICES
APPENDIX A
How to process ENVISAT ASAR Alternating Polarization (dual) mode data to delineate the outlines of reservoirs using Erdas Imagine9.1 and ArcGIS9.2

1. ENVISAT-ASAR ASA_APS DATA

2. IMPORT INTO ERDAS IMAGINE USING A LINEAR TRANSFORMATION OF 1

3. REDUCE SPECKLES BY USING GAMMA-ADAPTIVE FILTER IN ERDAS RADAR MODULE (7X7 WINDOW )

4. REDUCE SPECKLES BY USING GAMMA-ADAPTIVE FILTER IN ERDAS RADAR MODULE (5X5 WINDOW)

5. GEOCODE USING UTM COORDINATES ( FOR UER, IT IS ZONE 30N) ON THE WGS84 ELLIPSOID IN ARCMAP

6. PERFORM AN UNSUPERVISED CLASSIFICATION IN THE CLASSIFIER MODULE IN ERDAS IMAGINE. IF SATISFIED WITH THE RESULTS GO TO STEP 9, ELSE GO STEP 7

7. EDIT THE SIGNATURE OBTAINED IN THE UNSUPERVISED CLASSIFICATION IN THE ERDAS CLASSIFIER MODULE USING ONE OR SAMPLE SAMPLE SITE(S) TO CLASSIFIER AREAS/OBJECTES OF INTEREST

GO TO STEP 8
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER

Use the screen shots below as a guide for all the steps!
Step 1.
Acquire ENVISAT ASAR data either on a DVD/CD ROM or on the hard disk

Step 2.
**Import data in Erdas**
- Open the Erdas Imagine Program on the computer
- Go to the Import Module
- **Type**: Select ENVISAT (Direct Read)
- **Media**: File if stored on the hard disk; and CD-ROM if it is on a CD or DVD
- **Input File (*.N1)**: browse to the file to be imported
- **Output File**: copy the default name and browse to the folder where the imported file is to be saved (use the Go to or the dropdown arrow in Look in). Paste the default name copied and rename as e.g. “asa_aps_1pnupa20070131.img” without the quotation marks

- The OK button is then activated. Click on Ok and go to step 3
to use a transformation of 1

- Tick the “Write Transform to image and Write GCP File” box. For transformation Order, select 1. It is not so necessary to save the GCP file unless it is to be used for co-registration. Click on ok to start importing the file.
- Click on ok (when the processing is completed, the OK button will be activated)
Step 3.

**Reduce speckles using a 7x7 window**

- In the radar module in Erdas, click on radar interpreter > Speckle Suppression
- **Input File:** browse to the *.img file created in step 2.
- Tick the box for “Calculate coefficient of Variation” and click ok
- Go back to the radar module > radar interpreter> Speckle Suppression. For
- **Input File:** browse to the *.img file created in step 2
- **Output File:** follow the same procedure as in step 2 but save it as e.g. “asa_aps_1pnpa20070131sp7x7.img” without the quotation marks
- **Coordinate type:** File (if it is not automatically selected)
- **Window size:** 7
- **Filter:** Gamma-map
- **Coeff. of Variation:** Go to session on the main menu bar > Session log, copy the coefficient of variation computed and paste it
- Click ok to start filtering
Step 4. Reduce speckles using a 5x5 window

Repeat step 3 but choose 5 for Window size instead of 7 and name the file as “asa_aps_1pnpua20070131sp5x5.img”

Step 5.
5a. Geocode using UTM coordinates

- Open the ArcMap program in ArcGIS9.2.
- Click on add data tool
- add asa_aps_1pnpua20070131sp5x5.img as a layer
- Right click an empty space in the tools box, go to Environments > General settings and set the environments (i.e. where to save the files etc.)
- In the tools box, click on data management tools > define projections
  - input dataset or feature class: Use the drop down arrow to select the file asa_aps_1pnpua20070131sp5x5.img or browse to the folder which contains this file
  - coordinate system: Select Geographic coordinate systems\World\WGS 1984.prj and click on add, click on apply, ok and another ok
- In the data management tools > click on projections and transformation > Raster > Project
  - Input raster: asa_aps_1pnpua20070131sp5x5.img
  - Output raster: e.g. 310107prj (it should be less than 10 characters)
  - Output coordinate System: Select projected coordinate system \UTM\WGS 1984\WGS 1984 UTM Zone 30N.prj (for Upper East Region of Ghana)
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER

- Click on environments and ensure that under general settings, the output coordinate is set to “As specified below” and specify the coordinate system as the previous step (UTM)
- Click on ok to start the projection

- Create a new map and add one of the bands of the projected data e.g. 310107_c1
- Add one band of the projected data as a layer

5b. In order to change the format for the projected image from grid to *.img

- Go to ArcTool box and click on Spatial Analyst Tools > Extraction > Extract by mask
- For
  - Input raster: use the drop down arrow and select the projected file e.g. 310107_c1 or browse to the file
  - Input raster or feature mask data: Select the same file
  - Output raster: save it under a name (less than 10 characters) followed by “.img” to get it into an image file format e.g. 310107_c1.img
  - Check the Environments to be sure it has the right settings and click on ok

Step6.
6a. To maintain the format and perform an unsupervised classification in ArcGIS

- Go to spatial Analyst Tools > Multivariate > Iso cluster
- For
  - Input raster bands: Add the three bands of the projected raster file *_c1, *_c2 and *_c3
  - Output signature file: give it a suitable name e.g. sig310107 (be mindful of where it is being saved since it will be needed for the classification)
  - Number of classes: depends on how many land covers is to be classified e.g. 6 classes
  - You can fill in the optional fields or use the default
  - In the Multivariate tool > Maximum likelihood
    - Input raster bands: add the three bands again
    - Input signature file: the signature created in the Iso Cluster (e.g. sig310107)
    - Output classified raster: give it a name
    - Fill the other fields or use the default values
6b. To perform an unsupervised classification in Erdas Imagine

- Go to the classifier module in Erdas Imagine
- Click on unsupervised classification
- For
  - **Input raster**: use the output from step 5b.
  - **Output cluster Layer**: give it a name and save it in the correct folder
  - **Output signature Set**: ditto
  - Open the file in ArcMap and check which class has been assigned for water
Step 7.
To edit the signature obtained in the unsupervised classification in Erdas for a supervised classification

- Go to the classifier module in Erdas
- Click on Signature Editor
- Go to file > open and browse to where the signature was saved during the unsupervised classification
- Select the Replace option and click on ok
- Go to the viewer module **without** closing the signature editor
- Select the Classic viewer option
- Browse to the file which was used for the unsupervised classification (that is the output file from step 5b.) and open it
- If prompted to build pyramid layers, select YES (Imagine uses a 2x2 resampling algorithm by default)
- Scroll both to the right and down to see the image or use the zoom out button to see the full image
- Zoom-in to an area which can be identified as water
- Go to file in the viewer module > New > AOI layer
- Click on the show tool palette for Top layer (the tool that looks like a hammer)
- In the AOI tools select the ellipse to create and ellipsoidal area of interest in the area that is identified to be water
- Go to the signature editor and highlight the class for water by clicking on the class number under Class #
- On the menu bar in the signature editor click on replace current signature(s) with AOI
Step 8.
To perform a supervised classification in Erdas Imagine

- Continue from step 7
- Select all the classes in the signature editor by holding on to the shift key and clicking on the class names
- Go to Classify in the signature editor menu bar and select supervised
- For
  - **Output file**: give it a name and save it to a folder
  - If threshold is to be performed then tick the output distance file option and give it a name
  - **None parametric rule**: None
  - **Parametric rule**: Maximum Likelihood
  - Click on OK to start the supervised classification

Step 9.
Add the classified image as a layer in ArcMap

Step 10.
To georeference the image using GCPs in ArcMap

- Add the ground control points to the image in the form of a shapefile (points, polygon, polyline etc.) obtained from a GPS defining a particular area of interest or use intersections of roads or well known points as control points. e.g. In the figure below; the shaded one is the GCP and the coloured area is the classified image
On the menu bar, right click an empty space and click on Georeferencing to add it to the main menu bar

- **For layer**: select the layer to be transformed/georeferenced

- Click on add control points

- Select a point in the image to be transformed by clicking on the point and move the cursor to the correct position where it should be using the control points
- Repeat this for as many points for which there are control points (Avoid using points at the extreme ends)
- Click on the “show links and error” button next to the control points to show the XY positions and the transformed XY positions in tabular form
- **For transformation**: Select 1st Order or 2nd order Polynomial (Affine) transformation
- Check the Total RMS Error to determine whether the transformation is acceptable

Go to georefencing > Rectify
- **Cell Size**: leave the default unless there are multi-image processing which requires a particular cell size, then it can be changed
- **Resample type**: accept the default which is Nearest neighbour which is applicable to both discrete and continues data
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER

- **Output location:** browse to the folder where the georeferenced image is to be saved
- **Name:** Give it an appropriate name
- **Format:** Imagine Image

![Save As dialog box]

- Save the work
- Add the georeferenced image as a layer in ArcMap
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER

Step 11.
Create a new shapefile (polygon) in ArcCatalog, this will be used for the outline of the reservoirs

Step 12.
Add the new shapefile to the data frame that contains the classified image

Step 13.
Perform an onscreen digitization to determine the area extent of the reservoirs

- Create a shapefile in ArcCatalog
  - Open the ArcCatalog program in ArcGIS or Click on the ArcCatalog icon in ArcMap
  - Right click an empty space in the extreme right pane

- Create a shapefile in ArcCatalog
  - Go to New > Shapefile
  - Name: give it a suitable name
  - Feature type: Select polygon
  - Spatial Reference: Click on edit > Select > Projected coordinate system > UTM > WGS 1984 > UTM Zone and click on “Add”
Add the shapefile as a layer in the data frame that contains the georeferenced image.
Right click on an empty space on the main menu bar and select Editor > start editing > Select the shapefile to be edited if there are a number of them and click on OK.
Go to editor > Start editing.
Select the sketch tool.
Mark the outline of a reservoir with the sketch tool.
When done, click on editor > Save edit.
Repeat this for all the reservoirs of interest.
When done, click on editor > Save edit > stop editing.
Step 14.

**Calculate the area of the polygon created in step 13 using Xtools Pro or Calculate Geometry in ArcMap attribute table**

- Go to tools (or use Alt + T) > Extensions > select XtoolsPro (if that extension is available; a trial version can be downloaded at [http://www.xtoolspro.com/download.html](http://www.xtoolspro.com/download.html))

- In XTools Pro > Table Operations > calculate Area, Perimeter, Length...

  - Select layer to measure: Select the shapefile created for the outlines of the reservoirs
  - Desired output: Select the appropriate unit
  - Check the parameters to be measured (e.g. Perimeter and Area) and click on OK
  - Open the attribute table of the shapefile to read the values of the parameters measured

If the Xtools extension is not available then follow the following steps to measure the parameters in ArcMap

- Open the attribute table of the shapefile
- Go to options > Add field
  - Name: e.g. Area
  - Type: Text (choose an appropriate length like 50 or 100 characters) and click on OK
  - Right click on the Area column > Calculate Geometry (if prompted that the calculation is being done outside an edit session; Select YES)
  - Select the appropriate units and click on OK
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER

- Save the edits
- Stop editing when done
- Save the work
APPENDIX B
How to import XYZ points from a GPS to Polygons in ArcGIS

1. CONNECT THE GPS TO YOUR COMPUTER VIA USB OR SERIAL PORT

2. OPEN THE GPS TRACKMAKER PROGRAM AND SELECT THE APPROPRIATE GPS INTERFACE IN THE GPS FUNCTION ON THE MENU BAR

3. SELECT THE CORRECT COMM PORT AND CLICK ON THE PRODUCT ID BUTTON TO RETRIEVE THE STORED ROUTES, TRACKLOGS AND WAYPOINTS

4. DOUBLE CLICK ON WAYPOINTS, GO TO TOOLS ON THE MENU BAR AND SELECT OPTIONS UNDER TOOLS. CLICK ON COORDINATES AND SELECT THE CORRECT ONE (RECTANGULAR GRIDS, UTM FOR UER)

5. SAVE THE FILE AS BOTH GPS TRACKMAKER FILE (*.gtm) AND TEXT FILE (*.txt)

6. OPEN THE TEXT FILE IN MICROSOFT EXCEL. FOR FILE TYPE, CHOOSE TEXT. OPEN THE TEXT FILE WHICH WAS SAVED IN GPS TRACKMAKER. CHOOSE DELIMITED FOR DATA TYPE, CLICK ON NEXT. FOR DELIMITERS, CHOOSE COMMA. CLICK ON NEXT. FOR COLUMN DATA, CHOOSE GENERAL

7. DELETE ROWS 1 TO 4. MAKE SURE THAT THE DATA POINTS IN COLUMN C ARE IN THE CORRECT ORDER. IF NOT, SORT THE DATA IN THAT COLUMN IN ASCENDING ORDER. NAME THE CELL IN THE NEW ROW(1)-COLUMN(E) AS EASTING, ROW(1)-COLUMN(F) AS NORTHERN, ROW(1)-COLUMN(G) AS DATE AND ROW(1)-COLUMN(J) AS ELEVATION. DELETE ALL OTHER COLUMNS EXCEPT THE COLUMNS WITH NAMES. MAKE SURE THE COLUMNS AFTER ELEVATION ARE ALSO DELETED. GO TO STEP 8
8. SAVE THE FILE AS CSV (COMMA DELIMITED) (*.csv). A POP-UP SCREEN WILL APPEAR SAYING: *.csv MAY CONTAIN FEATURES THAT ARE NOT COMPATIBLE WITH CSV. DO YOU WANT TO KEEP THE WORKBOOK IN THIS FORMAT? CLICK ON YES, SAVE THE WORK AND CLOSE THE FILE.

9. OPEN ARCCATALOG IN THE ARCGIS PROGRAM. ON THE EXTREME RIGHT PANE, BROWSE TO THE FOLDER WHERE THE TEXT (*.csv) FILE WAS SAVED.

10. RIGHT CLICK ON THE *.csv FILE AND CLICK ON CREATE FEATURE CLASS FROM XY TABLE. IN THE INPUT FIELDS NAME THE XFIELD AS EASTING, YFIELD AS NORTHERN AND ZFIELD AS ELEVATION

11. CLICK ON THE COORDINATE SYSTEM OF INPUT COORDINATES... , CLICK ON SELECT. SELECT PROJECTED COORDINATE SYSTEMS/UTM/WGS1984 AND SELECT THE CORRECT UTM ZONE (FOR UER IT IS WGS 1984 UTM ZONE 30N.prj) , NAME IT OR ACCEPT THE DEFAULT NAME AND CLICK OK TO SAVE THE FILE (*.shp)

12. OPEN THE ARCMAP PROGRAM IN ARCGIS. DRAG THE *.shp FILE FROM ARCCATALOG TO ARCMAP OR USE THE ADD DATA FUNCTION IN ARCMAP TO ADD IT AS A LAYER

13. ON THE MENU BAR CLICK ON XTOOLSPRO. IF IT DOESN’T APPEAR ON THE MENU BAR, CLICK ON TOOLS > EXTENSIONS AND SELECT XTOOLSPRO. IN XTOOLSPRO, CLICK ON FEATURE CONVERSION > CLICK ON MAKE ONE POLYGON FROM POINTS. SAVE IT (OUTPUT STORAGE). GROUP BY FIELD: SELECT NONE OR DATE AND CLICK ON OK

14. CHECK FOR LOOPS IN THE OUTLINE OF THE POLYGON CREATED. IF DATA IS RECORDED IN VERY CLOSE RANGE, THE INACCURACY OF THE GPS CAN CAUSE THESE ARTIFACTS. IN THESE CASES, EDIT THE POINT FILE BY MOVING THE POINTS IN QUESTION IN A MEANINGFUL WAY, OR DELETE THEM USING XTOOLSPRO. TO EDIT THE POINTS IN ARCMAP, RIGHT CLICK ON THE MENU BAR, AND CLICK ON EDITOR. THE EDITOR THEN APPEARS ON THE MENU BAR IF IT IS NOT ALREADY THERE
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER

15. IN EDITOR, CLICK ON START EDITING. EDIT BY DRAGGING/MOVING OR DELETING THE POINTS WHERE NECESSARY. CLICK ON SAVE EDITS AND THEN STOP EDITING WHEN SATISFIED WITH THE OUTLINE

16. ADD THE SUFFIX "_EDITED" TO THE FILENAMES OF THOSE FILES WHERE SUCH EDITING WAS NECESSARY SO IT WILL BE EASY TO TRACE THEM, REPEAT STEP 13 AND CONTINUE WITH STEP 17.

17. IN XTOOLSPRO, CLICK ON TABLE OPERATIONS, CLICK ON CALCULATE AREA, PERIMETER, LENGTH, ACRES AND HECTARES. IN THE SELECT LAYER TO MEASURE BOX: SELECT THE POLYGON CREATED IN STEP 13. FOR DESIRED OUTPUT UNITS, SELECT METERS AND CLICK OK. OPEN THE ATTRIBUTE TABLE OF THE POLYGON TO SEE THE COMPUTED PERIMETER AND AREA

This session of the technical annex was prepared with some inputs from Jens Liebe
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER

APPENDIX C

Linear Regression of $\text{Area}_{\text{field}}$ and $\text{Area}_{\text{Sat}}$

SUMMARY OUTPUT

<table>
<thead>
<tr>
<th>Regression Statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple R</td>
</tr>
<tr>
<td>R Square</td>
</tr>
<tr>
<td>Adjusted R Square</td>
</tr>
<tr>
<td>Standard Error</td>
</tr>
<tr>
<td>Observations</td>
</tr>
</tbody>
</table>

ANOVA

<table>
<thead>
<tr>
<th>df</th>
<th>SS</th>
<th>MS</th>
<th>F</th>
<th>Significance F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regression</td>
<td>1</td>
<td>1844.01</td>
<td>1844.01</td>
<td>494.59</td>
</tr>
<tr>
<td>Residual</td>
<td>17</td>
<td>63.38</td>
<td>3.73</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>18</td>
<td>1907.39</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Coefficients</th>
<th>Standard Error</th>
<th>t Stat</th>
<th>P-value</th>
<th>Lower 95%</th>
<th>Upper 95%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>0</td>
<td>#N/A</td>
<td>#N/A</td>
<td>#N/A</td>
<td>#N/A</td>
</tr>
<tr>
<td>$\text{Area}_{\text{Sat}}$</td>
<td>0.93</td>
<td>0.04</td>
<td>22.24</td>
<td>0.00</td>
<td>0.84</td>
</tr>
</tbody>
</table>
Delineation of reservoirs using radar imagery in a semi-arid environment: A case study in the UER

### RESIDUAL OUTPUT (when the intercept is set to zero)

<table>
<thead>
<tr>
<th>Observation</th>
<th>Predicted Area_{field} (ha)</th>
<th>Residuals</th>
<th>Standard Residuals</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.70</td>
<td>0.37</td>
<td>0.19</td>
</tr>
<tr>
<td>2</td>
<td>8.81</td>
<td>-0.41</td>
<td>-0.22</td>
</tr>
<tr>
<td>3</td>
<td>2.21</td>
<td>1.61</td>
<td>0.86</td>
</tr>
<tr>
<td>4</td>
<td>9.11</td>
<td>1.75</td>
<td>0.93</td>
</tr>
<tr>
<td>5</td>
<td>4.72</td>
<td>-0.17</td>
<td>-0.09</td>
</tr>
<tr>
<td>6</td>
<td>1.54</td>
<td>1.37</td>
<td>0.73</td>
</tr>
<tr>
<td>7</td>
<td>9.51</td>
<td>1.56</td>
<td>0.83</td>
</tr>
<tr>
<td>8</td>
<td>6.43</td>
<td>-0.45</td>
<td>-0.24</td>
</tr>
<tr>
<td>9</td>
<td>19.29</td>
<td>0.79</td>
<td>0.42</td>
</tr>
<tr>
<td>10</td>
<td>25.55</td>
<td>-1.63</td>
<td>-0.87</td>
</tr>
<tr>
<td>11</td>
<td>3.56</td>
<td>0.86</td>
<td>0.46</td>
</tr>
<tr>
<td>12</td>
<td>4.04</td>
<td>-0.65</td>
<td>-0.35</td>
</tr>
<tr>
<td>13</td>
<td>6.82</td>
<td>-0.26</td>
<td>-0.14</td>
</tr>
<tr>
<td>14</td>
<td>0.75</td>
<td>2.91</td>
<td>1.55</td>
</tr>
<tr>
<td>15</td>
<td>13.27</td>
<td>-1.89</td>
<td>-1.01</td>
</tr>
<tr>
<td>16</td>
<td>14.74</td>
<td>-0.59</td>
<td>-0.32</td>
</tr>
<tr>
<td>17</td>
<td>4.88</td>
<td>5.98</td>
<td>3.19</td>
</tr>
<tr>
<td>18</td>
<td>0.96</td>
<td>0.47</td>
<td>0.25</td>
</tr>
</tbody>
</table>
## APPENDIX D

Computer Specifications for ENVISAT ASAR image analyses in ERDAS IMAGINE V9.1 and ArcGIS9.2

For Windows:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>1GB or higher</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 2000 Professional SP2 or higher</td>
</tr>
<tr>
<td></td>
<td>Windows XP Professional x64 Edition SP1 or higher</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2—5 SP1 or higher</td>
</tr>
<tr>
<td>Display</td>
<td>Super VGA 1024x768x32 or higher</td>
</tr>
<tr>
<td></td>
<td>DirectX 9 or higher</td>
</tr>
<tr>
<td>Hard disk capacity</td>
<td>40GB or more</td>
</tr>
</tbody>
</table>

[Accessed online: 05/04/07]